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Erlauterungen:

2013 wurde am Dreilandereck in Aachen (Landschaftsschutzgebiet) durch den Verein Gelandefahrrad
e.V. ein Bikepark (2-3 ha groR) errichtet. Unter Beteiligung des Landschaftsbeirats wurde mit
Genehmigungsbescheid vom 05.03.2013 eine auf 2 Jahre nach Inbetriebnahme befristete
landschaftsrechtliche Befreiung fiir die Einrichtung und den Betrieb des Bikeparks erteilt.

Der Bikepark hat laut Angaben des Vereins zum Ziel ,den Mountainbikesport auf eine im Verhaltnis
zum gesamten Wald geringe Flache zu konzentrieren und dazu beizutragen, das illegale Fahren im
restlichen Waldgebiet zu reduzieren®. Derzeit sind 600 Mitglieder im Verein auf der Strecke aktiv
(Stand Mai 2015), hinzu kommen nochmals 100-200 Gastnutzer jahrlich. Die Nutzungszeit des Parks
liegt zwischen Sonnenaufgang und Sonnenuntergang, hauptsachlich am Wochenende. Die Anlage
kann ganzjahrig genutzt werden. Die Benutzer des Parks reisen laut Angaben des Vereins
hauptsachlich mit dem Fahrrad an; Nutzer, die mit dem PKW anreisen, kdnnen vorhandene Stellplatze

am Dreilanderturm nutzen.

Seit 2013 wurden folgende Elemente auf der Strecke eingerichtet:

o Gemeinsamer Anfangspunkt der drei Streckenabschnitte ist ein Startturm aus Holz (seitlich
offene Bauweise, 5 m hoch, ca. 17 m lang). Vom Dreildnderweg ist der Turm aufgrund des
Birkenbestands wahrend der Vegetationszeit kaum einsehbar (siehe Foto)

e Vom Startturm aus erfolgte bislang die Anlage von 2 Downhill-Strecken (jeweils etwa 400 m
lang, auf je rund 1,5 m Streckenbreite)

o Weiter erfolgte die Anlage einer Singletrail-Strecke (70 cm breit)

o Aufdem Gelande ist an verschiedenen Stellen Werbung fiir Sponsoren angebracht — diese
wurde so angebracht, dass sie von den Nutzern der Strecken — aber nicht direkt fiir sonstige
Waldbesucher von den Wegen aus — sichtbar ist.

e Zur Unterhaltung der Strecken werden an mehreren Stellen des Gelandes Kies und Erde
(<1m?) gelagert und zur Ausbesserung/ Unterhaltung der Streckenabschnitte vorgehalten.

o  Weiter gibt es fiir die Unterbringung von Werkzeugen einen abschlielbaren Container.

e e o

X I

Nahere Informationen zum Bikepark, insbesondere zum Verlauf und zur Ausstattung der Strecken
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kdénnen den beigefiigten Antragsunterlagen entnommen werden.

Aktuell wird der Park um eine Freeride-Strecke erweitert (diese war bereits Bestandteil des Antrags
aus 2013 und wird von der Befreiung Bescheid vom 05.03.2013 umfasst). Die Freeride-Strecke
umfasst entgegen den Angaben aus dem Antrag von 2013 jedoch mehr sog. kiinstliche Elemente
(siehe Streckenplan in den beigefiigten Antragsunterlagen) — dies wurde mit FB 36/82 abgestimmt.
Auch der Verlauf der Strecke (siehe Ubersichtsplan, gelb) wurde mit dem FB 36/82 (Hr. Dr. Kramer,
Hr. Odrost) abgestimmt und markiert.

Mit Antrag vom 08.05.2015 beantragt der Verein Geldandefahrrad Aachen e.V. nun eine erneute

landschaftsrechtliche Befreiung fiir den dauerhaften Betrieb/ Regelbetrieb des Bikeparks.

Wahrend des Regelbetriebs sollen auf dem Gelande regelmaflige organisierte Veranstaltungen
stattfinden. Der Verein beantragt, in der Anlage (a) ein bis zwei jéhrliche, interne
Vereinsveranstaltungen, z.B. Vereinsmeisterschaften sowie b) bis zu drei Test- und Werbeaktionen
von Sponsoren jahrlich zu organisieren.

Die Verwaltung beabsichtigt, diese Veranstaltungen nicht zum Gegenstand der Befreiung fiir den
Regelbetrieb zu machen und Befreiungen fir geplante Veranstaltungen jeweils auf gesonderten

Antrag hin zu prifen.

Anlage/n:
1. Antrag auf landschaftsrechtliche Befreiung

2. Erlauterungen zum Antrag
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Name, Vorname;

Dominik Brachmanski

StraBe, Hausnummer:

Jakobstrafle 158

PLZ, Wohnort:

52064 Aachen

Teiefon: E-Maii:

0151 222 41 788 vorstand@gelaendefahrrad-aachen.de
Stadt Aachen

-Untere Landschaftsbehérde-
Reumontstr. 1
52064 Aachen

Antrag auf Befreiung von den Verbotsbestimmungen des Landschaftsplans der
Stadt Aachen 1988 nach dem Bundesnaturschutzgesetz /
Landschaftsschutzgesetz NW

Gemarkung: Flur: Flurstiick(e):
Rage Laurensberg 1 31
Projektbezeichnung: Bikepark Dreilandereck
(agfls. auf
gesondertem Blatt)

Sehr geehrte Damen und Herren,

zur Verwirklichung des oben angegebenen Projektes innerhalb des Geltungsbereichs
des Landschaftsplans der Stadt Aachen ist eine Befreiung nach den Bestimmungen
des Bundesnaturschutzgesetzes (BNatSchG) bzw. Landschaftsgesetzes (LG NRW)
und diesem nachgeschalteter Bestimmungen erforderlich.

Hiermit beantrage(n) ich/wir die Befreiung nach den naturschutzrechtlichen
Bestimmungen.

Ich/Wir nehme(n) zur Kenntnis, dass die Entscheidung Uber einen Antrag auf
Befreiung gebuhrenpflichtig ist.

Mit freundlichen GriiRen

1

{en) Antragsteller(in)

Anlage: Projektvorstellung
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Antrag zwecks Befreiung gemaf3 § 69 LG.
Sehr geehrte Damen und Herren,

wir wenden uns an Sie mit dem Anliegen, eine landschaftsrechtliche Befreiung des
Flurstiicks 1, Flur 31 der Gemeine Laurensberg, Stadt Aachen zu erwirken. Dies soll zur
Aufnahme des Regelbetriebs des dort befindlichen Bikeparks geschehen. Im folgenden
Schreiben werden diese Kapitel enthalten sein:

Inhalt

1.) Begriffsklarung:
I.  Kinstlich, naturahnlich, naturnah

[I.  Vorstellung diverser Beispielhindernisse
2.) Plan zu Lage und Art der Strecken
3.) Artund Intensitat der Anlagennutzung und Nutzungszeiten

[.  Allgemeiner Betrieb

[I.  Veranstaltungen
4.) Informationen zu Nebeneinrichtungen/ Baubetrieb/ Sponsorenwerbung
5.) Stellplatzbedarf
6.) Vereinsprofil
7.) Anlagen
8.) verzeichnis

1
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1) Begriffsklarung

1.I) Kiinstlich, Naturnah, Naturdhnlich

Zur Verbesserung des Sachverstandnisses im Bezug auf landschaftsasthetische und
bauliche Aspekte sollen die im Bikepark befindlichen und geplanten Elemente
kategorisiert werden. Deshalb soll anhand des verwendeten Materials und des Eingriffs
in die Landschaft und Umwelt zwischen kiinstlich, natiirlich bzw. naturahnlich
unterschieden werden. Danach sollen die haufigsten Bauformen anhand von
Abbildungen erlautert werden.

Kiinstliche Hindernisse (i)

Ein kiinstliches Hindernis wird aus nicht im Wald vorhandenen Materialien errichtet. Im
Speziellen bedeutet dies, dass alle Elemente aus verarbeitetem (gesdgtem, ansonsten
unbehandeltem) Holz und aus gebietsfremdem Erdmaterial hierzu gezahlt werden.

Um Stabilitat und Sicherheit der Hindernisse gewahrleisten zu kdnnen, wird eine
Massivholzbauweise aus hochwertigen Holzern (etwa Douglasie oder Larche)
angewendet. Die Qualitdt der Umsetzung wird von erfahrenen und qualifizierten
Mitgliedern (Sageschein, Ausbildung im Handwerk) des Vereinsbauteams sichergestellt
und tiberwacht. Weil grundsatzlich unbehandeltes Holz verwendet wird, muss mit
einem Nachgrauen der Oberflachen gerechnet werden.

Der Vorteil eines auf diese Weise gebauten Elements ist die Moglichkeit, aus sportlicher
Sicht notwendige, komplexe Elemente mit einem vergleichsweise geringen Eingriff in
den Boden errichten zu konnen, weil kleine Fundamente (z.B. Bodeneinschlaghiilsen,
vereinzelt Punktfundamente) zur Verankerung ausreichen und kein Aushub im Gebiet
vorgenommen werden muss.

An Stellen mit erhohtem Sturzrisiko (insbesondere Landungen von grofden Spriingen)
und auf ebenen Streckenabschnitten wurde LAGA Z0 zertifizierte Fremderde nach
Absprache mit Herrn Quil (FB 36/52, Sachgebiet Nachsorgender Bodenschutz)
verwendet. Der Einsatz von Erde geschieht im Rahmen der Sicherheit zur Vermeidung
von Verletzungen durch scharfe Kanten oder Hangenbleiben von Gliedmafien in Liicken
zwischen Brettern, Verringerung des Sturzrisikos bei schiefer Landung durch
Glattebildung bei Nasse und Ausschlief3en eines Bruchs von Holzkonstruktionen wegen
Anderung der Materialeigenschaften iiber die Zeit (Schidigung durch Lastwechsel,
Witterung) oder durch Belastungsspitzen.

Naturahnliche Hindernisse (ii)

Ein naturdhnliches Hindernis wird aus im Wald vorhandenen Materialien errichtet und
schliefdt eine Gelandemodellierung ein. Naturdhnliche und natiirliche Hindernisse
konnen kombiniert werden (z.B. gebauter Sprung in einen vorhandenen Hang). Die
meisten Elemente im Bikepark sind derart gestaltet.

Haufig wird eine Befestigung in Form eines Holzrahmens, meistens aus praparierten

Stammen, vorgenommen werden muss um Regenerosion und dem Abtragen durch das
Befahren standzuhalten.

2
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Naturnahe Hindernisse (iii)

Ein naturnahes Hindernis nutzt die Gelaindebeschaffenheit aus, die zum Zeitpunkt des
Anlegens der Strecken schon vorhanden ist und in den Streckenverlauf ohne
Verdanderung durch Werkzeug integriert werden kann. In diese Kategorie fallen sowohl
topografische Gegebenheiten (wie Hange), aber auch Bodenbeschaffenheiten (wie
Wurzel- oder Steinfelder) oder beides in Kombination (z.B. steiles Hangstiick mit
Absatzen durch hervorstehende Steine und/oder Wurzeln).

Der Bauliche Aufwand beschrankt sich auf das Anlegen einer Fahrspur, weil es sich um

Objekte handelt, die in dhnlicher Form natiirlicherweise im Wald vorkommen und
gegeben sind.

3
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1.II) Beispiele fiir Hindernisse und Zuordnung von o.g. Kategorien i-iii

Wurzelfelder/Steilhange/ Prallschutz, (i): An Auslaufen von schwierigen Spriingen und Kurven, in
Schrighinge, (ii): Natiirliche denen Baume stehen, soll ein Prallschutz montiert werden, damit
Gegebenheiten werden Verletzungen durch Fahrfehler vorgebeugt wird. Es wurden entgegen der
weitgehend unverandert in Abbildung dunkle Farben verwendet. Bedruck der Folie mit

die Strecken tibernommen. Sponsorenlogos als Moglichkeit der Werbeplatzierung. Verwendung

insbesondere im Bereich der Aushubkrater im Fichtenwald, nach dem
Startturm und am Sprung ,Watzke“ (siehe Anlage Streckenbuch).

ey ZN -:;L,}—; PO
Stepdown /Stepup, (i)-(ii):
Sprung mit negativer/positiver

Gelandedrop, (ii)-(iii): Sprung mit negativer H?hendlffer.enz mit kleinem Vef"}}altnls aus
Hohendifferenz und grofiem Verhéltnis von Hohe zu liElhe pu eie. Uiegen CeT Ien B gt :
Weite. Natiirliche Gegebenheiten werden erganzt und AbSpI'l:ll’lg- und" La}ndeformgebung LI LS
so nachtréglich in den Streckenverlauf integriert. (im Eieite iz b gl

Kraterbereich)

Oft leichte Formgebung notwendig.

4
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=T At ) : .
Double/Table/Sonderformen ebener Spriinge, oft (i), selten auch (ii) oder (iii):
Ebene Spriinge benoétigen angeschiittete oder kiinstlich gebaute Landungen und Abspriinge. Bei einem sog.
Table ist die Liicke zwischen Absprung und Landung durch Erdanschiittung oder durch eine Briicke (z.B. aus
Holz) geschlossen, sodass insb. Anfidngern ein Herantasten an gréfere Sprungweiten ermoglicht wird.
Ausfithrung auf den Bilden als massives Erdelement. Pflanzen werden sich auf den nicht befahrenen Teilen
der Elemente bilden, sodass diese Elemente mit der Zeit an Auffilligkeit verlieren und an Stabilitat
gewinnen.

Bodenwellen, (i)-(iii): sehr
unauffalliges Element, das durch
Umverteilung oder geringen
Erdeinsatz entsteht und diverse
Maglichkeiten fiir die Fahrer bietet.

Fahrflusses und der Geschwindigkeit. Anderung der
Gelandeform durch Anschiittung und Befestigung durch
Rahmen (je nach Bodenbeschaffenheit und Grofde auch ohne
Rahmen)

5
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Holzdrop (1) Ein aus Holz gebauter Drop (mlt und ohne Nutzung der Seltenﬂ;lche durch
Sponsorwerbung) ist immer dann notwendig, wenn sich durch die Geldndesteilheit zwar eine Landung
anbietet, der Absprung aber nicht aus dem vorhandenen Gelande heraus errichtet werden kann.

i Egh
549.
‘ﬂ

Wallrides (1) nahezu senkrechte Wand, entweder gerade oder gekrummt
Bietet eine grofde Flache, auf der Werbung entsprechend obiger Darstellung
platzierbar ist.

Startturm

Als gemeinsamer Anfangspunkt aller drei Strecken wurde ein Startturm aus Holz
errichtet. Aufgrund der flachen Gelandeform im oberen Teilstiick ist ein solcher Turm
notwendig um die Fahrer auf eine ausreichende Startgeschwindigkeit zu beschleunigen.
Die Hohe dieses Elements betrdagt 5m (Podesthéhe) und generiert damit eine
Startgeschwindigkeit von 35-40 km/h. Die Platzierung des Startturms wurde in
Zusammenarbeit mit der Gemeinschaft Natur- und Sportfreunde Aachen e.V. gewahlt,
sodass eine Beeintrachtigung der Privatsphare der dort Freikorperkultur-treibenden
durch Sicht vom Startturm ausgeschlossen ist.

Aufgrund der Entfernung zum Weg, der seitlich offenen Bauweise und dem dazwischen
befindlichen Birkenwald hat der Turm wahrend der Vegetationszeit der Biume vom
Weg aus nur eine geringe Auffalligkeit.

6

10 von 32 in Zusammenstellung



I W e |

o

THIS DRAWING HAS BEEN PRODUCED USING AN EXAMPLE
TEMPLATE PROVIDED BY UGS.

L

FIRST 1SSUED THTLE

DRAWN BY Fdit DB_FPART_DESC Attribute

CHECKED BY

(File > Properties > Attributes)

APPROVED BY STZE[DWG NO. REV.
ALL DIMENSIONS IN MM A4 Baugruppe_ _dwgh A

3D CAD MASTER PART NAME: Baugruppe V|7 SCALE 11 SHEET | OF 2

T T 2T Zeweidemeedd | 56



ALL DIMENSTONS IN MM

3D CAD MASTER PART NAME:

Baugruppe

1720,p
1620,
=

.

- - - >

THIS DRAWING HAS BEEN PRODUCED USING
TEMPLATE PROVIDED BY UGS.

AN EXAMPLE

FIRST [SSUED

DRAWN BY

CHECKED BY

AFPPROVED BY

TITLE

Fdit DB_FPART_DESC

(File > Properties > Attributes)

ATTCribute

SIZE|DWG NO.

A4

Bougruppe _dwgl

REV.

/;

i

SCALE 1zl

SHEET 1 OF 2

|

’

:9 von 32in Z&Fammenstelluﬁb

D

®



o

£

/””. -
¢
y

N

N

I

+

! o o o o o o e ¢

|
|

—T

N I | S N ) N N N

THIS DRAWING HAS
TEMPLATE PROVIDED BY UGS.

PRODUCED USING AN EX

(AMPLE

FIRST [SSUED

DRAWN BY

CHECKED BY

TITLE

Fdit DB_FPART_DESC

ATCTr it

Utbe

~1 (File > Properties > Attributes
APPROVED BY SIZE[DWG NO. REV.
ALL DIMENSIONS A A4 Bougruppe_dwg4 3
3D CAD MASTER PAF@E\@?\EELE_:EQWer -+ SCALE 131 SHEET | OF 2

1  %ALE 57200

3 von 32in Z&gammenstelluﬁb



2.) Plan zu Lage und Art der Strecken

Mountainbiken ist dhnlich dem Skisport in mehrere Unterdisziplinen staffelbar. Weil
jede dieser Disziplinen einen anderen Anspruch an die Charakteristika der jeweiligen
Stecke hat, werden im Park verschiedenartige Strecken angelegt, um die einzelnen
Genres zu bedienen.

Zur Veranschaulichung wurde folgender Lageplan eingefiigt, auf dem geplante
Nutzungsflachen farbig markiert sind:

Entsprechend der Legende, kann zwischen einer Freeride -, Singletrail - und einer
Downbhillstrecke unterschieden werden. Die Bezeichnungen der Strecken stammen aus
dem englischen Sprachgebrauch und lassen sich nur sehr schwer exakt tibersetzen.

Der Begriff ,Downhillstrecke” driickt aus, dass es sich um eine anspruchsvolle
Abfahrtsstrecke handelt, ein ,Singletrail” ist einem Wanderpfad dhnlich und entspricht
einem schmalen, nur stellenweise befestigten und modellierten Pfad, ,Freeride“
bezeichnet eine stark modellierte Strecke mit einem hohen Anteil kiinstlicher Elemente.

10
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Alle Strecken beginnen an der rot markierten Startrampe.
Im tiirkis markierten Bereich wurden zwei Strecken angelegt, die in die Kategorie
Downbhill fallen. Es wurde angestrebt, die gegebene Geldandeform mit Hilfe einiger
naturnaher und naturdhnlicher Hindernisse moglichst effizient zu integrieren. Steile und
grofde Krater als vorhandene Gegebenheit im oberen Teilstiick werden genutzt. Im
Bereich der Krater teilt sich die gemeinsame Trasse auf.

Zum Beginn der Strecke wird ein nahe am Asphaltweg liegendes Relief genutzt, der
minimale Abstand betragt 7m, aufierdem ist in diesem Bereich eine Abzaunung
eingerichtet. Die Lange dieses Abschnitts betragt etwa 40m. Die Downhillstrecken sind
jeweils etwa 400m lang. Der Platzbedarf der Strecke betragt bis auf wenige Ausnahmen
(Sicherheitsbreite bei Abspriingen und Landungen) ca. 1.5m.

Der Singletrail (lila) wurde mit dhnlichen Mitteln, wie die Downhillstrecken gestaltet
und weist vorwiegend natiirliche Hindernisse auf, im vergleichbar kleinem Umfang
wurden naturdahnliche Hindernissen integriert. Die Strecke erhalt so den Charakter eines
schmalen Pfades und ist ca. 70cm breit.

Der Freeride (gelb) wird im Siefen verlaufen und aufgrund der dort teilweise hohen
Bodenfeuchtigkeit und des sportlichen Anspruchs einige kiinstliche und naturdhnliche
Hindernisse beinhalten. Ein Streckenentwurfsplan ist anbei.

Die Streckenverlaufe wurden auf mehreren Begehungen mit Herrn Odrost
(Revierleitung Stadtische Waldgebiete westlich der B 258, Dreilandereck, Brander
Wald) und Herrn Dr. Kramer (Abteilungsleiter FB 36/82) zusammen festgelegt und

11
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markiert. Es wurde darauf geachtet, dass die Streckenfiihrung waldmaf3ige und
sportliche Interessen gleichermafen beriicksichtigt.

Das zur Errichtung naturdhnlicher Hindernisse bendétigte Material wurde wahrend der
Bauphase 2013 vollstandig aus dem Gebiet entnommen, lediglich auf der
Freeridestrecke und an einem Tablesprung (siehe Anlage 3) wird LAGA Z0 Zertifizierte
Fremderde zum Bau des Elements eingesetzt.

3.) Art und Intensitit der Anlagennutzung und Nutzungszeiten

3.I) Allgemeiner Betrieb durch Verein

Nach Gestattungsvertrag ist eine Nutzung der Anlage im Zeitraum zwischen
Sonnenaufgang und Sonnenuntergang erlaubt.

Derzeit sind 600 Mitglieder (Stand 03.05.15) im Verein aktiv. Hinzu kommen etwa 100 -
200 Gastfahrer im Jahr. Das Altersprofil des Vereins hat seinen Durchschnitt bei 29,2
Jahren (Stand 03.05.2015), die meisten Mitglieder sind berufstatig oder im Studium und
finden unter der Woche zumeist nur Nachmittags und Abends die Méglichkeit auf der
Anlage zu fahren, die Hauptnutzungstage fallen daher auf die Wochenenden und in die
Ferienzeiten. Die Anlage ist ganzjahrig und an sieben Tagen in der Woche geoffnet.

Das Gastfahrerpublikum beschrankt sich auf Mitgliedschaftsinteressenten (eine
Verrechnung des Tageskartenpreises wird angeboten) und auf unregelmaf3ig
wiederkehrende Besucher aus dem weiteren Grenzgebiet (B, NL) , sowie der ndheren
Umgebung (D). Aufgrund der Preisgestaltung ist fiir Sportler aus dem naheren
Grenzgebiet ist eine Mitgliedschaft bereits nach vier Fahrten lukrativ. Grof3ere,
kommerziell betriebene Bikeparks mit Infrastruktur im Umkreis von ca. 40
Autominuten um Aachen ziehen Touristen von Aufderhalb weitgehend aus dem
Aachener Gebiet ab. (Parks: Filthytrails - Maas Mechelen, Bikepark Ferme Libert -
Malmedy, Nordeiffel Gravity Park — Simonskall). Der Bikepark dient vorrangig der lokal
ansassigen Interessengemeinschaft.

3.II) Veranstaltungen

Es soll eine vertraglich regulierte Nutzung des Bikeparks durch Sponsoren und Verein
im Rahmen von organisierten Veranstaltungen stattfinden. Sponsoren sollen die Anlage
bis zu drei Mal im Jahr fiir Testangebote und Werbeaktionen nutzen kénnen
(Veranstaltungen mit Fremdbeteiligung), der Verein selbst soll bis zu zwei intern
Veranstaltungen (Vereinsmeisterschaften) im Jahr durchfiihren diirfen.

Transparenz beziiglich der Fremdnutzung durch Sponsoren wird gewahrleistet durch
vorab zugewiesene Gastkartenkontingente.

Die Sponsoren fiihren keine Veranstaltungen durch, bei denen motorbetriebene
Fahrzeuge oder Beschallungstechnik im Bikepark oder umliegenden Waldgebiet zum
Einsatz kommen. Zeitweilige werbewirksame Einrichtungen (Werbestande, die iiber
einen Strom- und Wasseranschluss verfiigen, Fahrzeuge) werden grundsatzlich aus dem
Raum Wald ausgelagert.

Bei Witterungsbedingungen, bei denen das Befahren der Strecken zu grofie

Erosionsschaden verursachen wiirde (etwa bei oder unmittelbar nach sehr starkem
Regen) oder bei denen das Befahren der Strecken eine Gefahrdung fiir die Nutzer

12
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darstellt (Gewitter, Sturm, starker Schneefall), wird per Internet ein Hinweis auf eine
sich aus dem Regelwerk ergebende Sperrung der Strecken ausgesprochen.

Die Einhaltung der Sperrung obliegt dem einzelnen Nutzer in Eigenverantwortung. Es
findet keine Einrichtung von Barrieren statt. Hinweisbeschilderung am Startturm
(Nichtbenutzung bei Glatte) wurde installiert, im Regelwerk (Bikeparkschildtafeln an
jedem Zu- und Ausgang) steht der betreffende Passus fiir ein Befahrungsverbot unter
den o.g. Witterungseinfliissen geschrieben. Des weiteren Unterschreibt jedes Mitglied
und jeder Gastkartenkaufer, das Regelwerk gelesen, verstanden und akzeptiert zu
haben.

4.) Informationen zu Nebeneinrichtungen/ Streckenbau/ Sponsorwerbung im
Park

Auf dem Geldnde des Bikeparks befindet sich ein abschlief3barer Container zur
Aufbewahrung von Handwerkzeugen, die bei der Pflege der Anlage eingesetzt werden.
In geringen Mengen lagert neben der Strecke an einigen Stellen Material zur Pflege.
(Kies- und Erdhaufen je <1m3) Zudem sind im Startturm das Streckenbuch, sowie
Verbandsmaterial untergebracht

Streckenbau und Pflege werden von einem ca. 25 Personen starken Team durchgefiihrt.
Es kommen tiberwiegend Handwerkzeuge zum Einsatz. Die Sdgescheine der Personen,
die auf dem Geldnde Sagearbeiten durchfiihren, wurden vom Verein gesammelt und
dem Forstamt libermittelt. Nach Bedarf (wenn Erdbewegungen notwendig) werden
auch Maschinen auf dem Geldnde eingesetzt. Zu Maschinenfahrspuren,
Materialabladeorten und Werkzeug An- und Abfahrt (falls spezielles Werkzeug benétigt
wird) werden Absprachen mit dem Forstamt getroffen.

Die Baukosten werden zu einem grof3en Teil durch Sponsoren gedeckt, daher wurden in
Absprache mit dem Forstamt Orte im Bikepark abgesteckt, an denen Sponsoren die
Moglichkeit bekommen, sich werbewirksam im Park zu platzieren. Die Werbung wird
von Hauptwegen aus nicht-sichtbar platziert, die Werbewirkung soll stattdessen durch
das Abbilden des Sponsors auf Fotos (z.B. Parkwerbung in der Presse oder auf der
Internetseite unseres Vereins) und die Sichtbarkeit fiir die Fahrer erfiillt werden.

5.) Stellplatzbedarf

Die meisten Nutzer der Anlage sind im Innenstadtbereich wohnhaft und reisen deshalb
direkt per Fahrrad an. (Siehe Verteilung der PLZ-Bereiche in Anlage 4 - Statistik)

An Tagen hoher Frequentierung rechnen wir deshalb mit einem Stellplatzbedarf von 10-
15 KFZ. Die Anfahrt wird vom Verein liber Belgien (Kelmis, Gemmenich) oder tiber die
Niederlande (Vaals) ausgewiesen.
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6.) Vereinsprofil

Der Verein spricht mit dem Projekt bereits eine grofde Zahl von Sporttreibenden an.
Bereits jetzt erhalten wir positives Feedback zur Art der Streckenumsetzung. Es ist
gelungen, die Streckenelemente in das Geldnde und die Umgebung zu integrieren.
Kiinstliche Elemente mit grofiem Fremdmaterialeintrag beschranken sich auf
Ausnahmen, natiirliche Gegebenheiten wurden in Kombination mit naturdahnlichen
Elementen ausgenutzt, sodass der Eingriff in den Boden flaichenmafig gering gehalten
wurde.

Die Finanzierung des Projekts wurde iiber Sponsoren gesichert. Wir mochten deshalb
die unter Punkt zwei beispielhaft dargestellten Werbefldachen auf einzelnen Elementen
anbieten konnen, sodass Sponsoren ihren Namen mit unserem Projekt in Verbindung
bringen kénnen. Werbeflachen wurden bei der Planung so platziert, dass sie fiir andere
Waldbesucher, die den Park nicht betreten, auch nicht unmittelbar sichtbar sind.

Neben dem Nutzen fiir die Sportler durch die Anlage, tragt das Projekt auch zur
Etablierung des gesamten Mountainbikesports bei, indem wir durch unsere
Zusammenarbeit mit den Behorden der Stadt, dem Forstamt und der Presse zur
Steigerung des Ansehens der Gemeinschaft beitragen und damit die Akzeptanz des
Sports im Allgemeinen erhéhen. Dem Eindruck mehrerer Befragter zu Urteilen hat sich
die bis dato angespannte Gruppendynamik bereits gebessert.

Der Verein engagiert sich seit Beginn im Bereich der Jugendarbeit und fiihrt im Bikepark
ebenfalls Nachwuchsforderung durch. Ebenfalls konnte ein grofer Teil des
Vereinslebens in Kooperation mit dem Kinder- und Jugendzentrum der Gemeinde St.
Hubertus gestaltet werden. Im Rahmen der Kooperation wird eine Fahrradwerkstatt,
sowie ein ,Pumptrack” (ebener Rundkurs auf dem Geldande des Kijuze) fiir die Kinder
und Jugendlichen des Kijuze betrieben, aufserdem finden dort einige Veranstaltungen
fiir das erwachsene Publikum des Vereins statt (Pumptracksession,
Saisonabschlussgrillen, gemeinsames Schauen von Sportveranstaltungen).

Das Projekt ,Bikepark Dreilandereck” hat das Ziel, den Mountainbikesport auf eine im
Verhaltnis zum gesamten Wald geringe Flache zu konzentrieren und dazu beizutragen,
das illegale Fahren im restlichen Waldgebiet zu reduzieren und die bis dato teils
angespannte Gruppendynamik zu entspannen.

Das Projekt wird durch den Sportausschuss und das Sportamt unterstiitzt und wurde fir
die Pilotphase im Umweltausschuss befiirwortet.

7.) Anlagenverzeichnis:

Bilderauswahl der aktuellen Strecken

Einordnung der bestehenden Elemente in die Klassifizierung nach (i), (ii), (iii)
Bilderauswahl und Planungsskizze Freeridestrecke (im Bau)
Mitgliederstatistik 2013

BN e
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Anlage 1: Bilderauswahl der aktuellen Strecken

1
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Anlage 2: Einordnung der bestehenden Elemente

2
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Streckenelemente 1/2 - Nordrampe (Singletrail/ Klappergasse)

Element

Sektion Startturm incl. Table bis

(i) kiinstliches Hindernis (ii) naturdhnliches Hindernis (iii) naturnahes Hindernis

Kategorie Beschreibung

ii Verdichtet und bnet
Abbiegung Singletrail (SO1) (i) sl s
Table (T01) (i) Angeschitteter Table
-> Einsti
Anlieger Einfahrt Singletrail (A01) (ii) Aus gebietsimmanentem Material gebaute Steilkurve instiegspunkt
Klappergasse
Flaches Stiick nach Anlieger bis . .
Pfad fi h I
Kicker (502) (iii) ad freigeschnitten und so belassen
Kicker vor Rechtskurve (K01) (ii) Absprung mit Verkastung, Landung nicht modifiziert
Rechtskurve und abgestiitzter .. . L .
Schrighang (S03) (ii) Steilkurve aus gebietsimmanentem Material
nicht abgestiitzter Schraghang . . .
und Wurzelfeld (504) (iii) Pfad Eingefahren ohne sonstige Befestigung
(AAnc:lze)ger im Hang nach Wurzelfeld (ii) Steilkurve aus gebietsimmanentem Material
Flaches Stiick nach Anlieger bis . . .
180° Kurve (505) (iii) Pfad Eingefahren ohne sonstige Befestigung
180° Kurve (A03) (i) Steilkurve aus gebietsimmanentem Material
Offenes S nach 180° Kurve bis (i) Enge, flache Kurve. Fahrerisch recht anspruchsvoll, obere Bodenschicht abgetragen, bis
Gelandestufe (S06) Feuersteinschicht freigelegt war
Gelndestufe (K02) (i) Bereits liegender Baumstamm mit etwas Erde angeschiittet (obere Bodenschicht von S-Kurven
verwendet) und so belassen

?:gz)tskurve HEEEHEIE LA (iii) Kurve nur freigeharkt, Steilkurve ist durch Wurzeln vorgegeben
Schraghang nach Rechtskurve vor (i)
Anliegerkurven (S07)
fr:ézg)erkurven UG AT (ii) Niedrige, weite Anliegerkurven, Abstilitzung <20cm Hohe

. . <- Sprung zum
Sekt‘lon bis VYatzke r}ach (ii) Geebnet und seitlich drainiert Einstiegspunkt
Abbiegung Singletrail (S08)

Klappergasse

Watzke (K03) (i) GroRter, nicht kiinstlicher Absprung im Park, Sprungweite bis zu 9m, Erdaushubstelle hat Funktion

Naturtable (T02)

(iii)

als Drainagegraben (ca 20cm breit) und wurde mit Geast und Krautbewuchs unsichtbar gemacht

Nur Absprung und Anfahrt durch Kuhle leicht geformt, Landung und Tableflache gegeben
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Steckenelemente 2/2 - Nordrampe (Klappergasse/ Korkenzieher)

Element

Wourzelfeld nach Naturtable bis
Einstieg Klappergasse (S09)

Anlieger und Einstieg

Kategorie Beschreibung

(iif)

Unverandertes Wurzelfeld

-> Einstiegspunkt

Klappergasse (A07) (i) Korkenzieher
Einstieg incl.
Krater 'r'1ach Hsiselne ... ;;»  Holzbriicke zur Vermeidung von Verschlammung und Erosion in der Kompressionszone (etwa am
Holzbriicke (HO1) und Stepup (iii) /(i) N .
Punkt der groRten Krimmung).
(K04)
Abschnitt nach Krater incl.
Stepdown (K05), Kurven (A08) bis (ii)
Blockhaus
Blockhaus (T03) (ii) Sprung mit Holzverkastung aus von einem Nachbargebiet zugekaufter Baumstamme.
Sektion ab Blockhaus bis Anlieger (i) Abstiitzung aus Baumstimmen
(S10)
Anlieger (A09, A10, A11) und (i) Anlieger geformt aus umverteiltem Material, groRflachig Abgetragen, Humusdeckschickt danach
Wellen (KO6) am Entnahmeort auf Boden wieder aufgetragen
Abschnitt nach Wellen bis Auslauf (i) Weitgehend Naturbelassen, lediglich zur Abbremsung eingerichtete Elemente aus kurzen
(S11) . Verschnittstiicken der Verkastungen
<-S

Sektion ab Naturtable bis . p'rung zum
Anlieger vor Kraterlinien (512) (i) Al LS

leger v n Korkenzieher
Anlieger vor Kraterlinien (A12) + (i)
Holzbriicke (HO3)
Profilinie ab Anlieger A12: -> Einstiegspunkt
Hipjump (KO7) + Anlieger unten (ii)/(i) Chickepra
(A13), Drop (H02) bis Stepup v
Umfahrung ab Hipjump: S-Kurven

<-S
(A14, A15, A16), Transfer aus (i) Einsrt’i;“"sg 3:';1
erster Kurve A14 in Droplandung . &sp
. Chickenway

bis Stepup
Stepup aus Kraterlinien (K08) (ii)
GroBer Anlieger Rechts (A15) (ii)
GroRBer Anlieger Links (A16) (ii)

Auslauf (513)

(iii)

Freigefahrener Pfas
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Anlage 3: Bilderauswahl Freeridestrecke und
Planungsskizze mit Kategorisierung der Elemente

+

Erdverteilungsplan Sektion I

3
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FRSO1EO05 S-ANLIEGER

FRSO01E03 ROLLER
FRS01E04 DOPPELROLLER

/,/
[ .

>/1/ ot

FRSO1E06 TABLE FRS02 SEKTION II

FRS01EO01 ANLIEGER

FRS01E08 HOHER ANLIEGER
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/ FTS01E02 HIPTABLE
(iii)

FRSO01EO01 ANLIEGER

Hels

FRS01E03 ROLLER

(iii)

(F_I%SOlE04 DOPPELROLLER
11l

FRS02E01 BRUCKE

(i)
FRSO1EO5 S-ANLIEGER
(iii)
'.;///:‘/"
A FRS02E02 S-KURVE
(ii)
. FRS02E03 DROPBATTERIE
//—:::\\\\ - e T AR, SIS
> ' FRS02E04 UBERQUERUNG SIEFFENT _ s
FRSO1E06 TABLE bz \ S ati e
(i) ™\ (i "
FRS03 SEKTION III
7 e “‘. ‘p S P
FRSO1E07 GAPSPRUNG, o
(iii) 6{/' N o PR oty
5135503501 LINKSANLIEGER - <
1l A
‘ 55503503 STEPDOWN
1l
FRSO1E08 HOHER ANLIEGER FRSO3E02 WALLRIDE AUF FRSO3EO1
(iii) (iii)

UMFAHRUNG UM FRS03EO5 T
MIT PLATEAU FUR ANFAHRT A?KABL-ELLINE :

» : ) o = ‘ Yy P

FRSO3EO05 HIPJUMP 70°
(i)

FRSO03E06 STEPDOWN
(iii)

FRS04E02 TABLE 10 m
(iii) .

F_R)SO4E02 TABLE 8 m
1

FRS04E04 S-KURVE FLACH
(i)
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Anlage 4: Mitgliederstatistik 2013
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B Manner

Frauen

Extrapolation Zuwachsrate
Zuwachsrate
e Vitgliederanzahl

== «= Extrapolation Mitgliderzahl



Mitgliederherkunft

85
Aachen (Stadt)
Umgebung (Gebiet 52, sowie NL und B)
B Sonstige
274
Altersgruppen
) 50 100 150 200 250

10-19 Jahre

20-29 jahre _ 14
B Ménnlich
30-391ahre _ 10 WeiinCh

50-59 Jahre 1

Altersdurschnitt: 29.4 Jahre
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